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      Dues NOTICE  _  
Effective January 1, 2006 there will be a 
change in membership fees and the time 
they will be due. 
 
At the August membership meeting a 
presentation was made covering the  
changes in the membership fees and the 
time they will be due. 
 
The membership made a motion to ac-
cept the new time and fee structure. It 
will become effective January 1, 2006 
 
The membership dues will be $12.00 
per year for everyone. They will be col-
lected during the month of January.  
There will NOT, repeat there will 
NOT be an invoice sent to the mem-
bership as in the past. The members 
will be expected to send  their checks, 
Made out to ACPCUG, to the club ad-
dress/ PO Box. The address is:                              
ACPCUG  
PO Box 2151  
Akron, Ohio  44309 
 
You may also turn your dues in at a club 

Akron-Canton PC Users Group 

  
 

We will be back at North Hill Library 
on Cuyahoga Falls Ave. for October 
2005. We are “assured” to be at 
the Main Library in December 
thanks to Walt Ruthenburg. 
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meeting.  Mr. Rick Lubinski will be accepting the dues in my absence  at the 
membership meeting in January. 
 
All members who have paid for more than one year will receive a letter from the 
Treasurer. The letter will have information covering the extension of your pay-
ment. You will be given credit for 2006 and any future years that your payment 
may cover. 
 
Membership fees are due in January, if they haven’t been paid by the end of Feb-
ruary the member will be delinquent and membership privileges will cease.  
 
 
 
Respectfully, 
 
Jim Albright 
Treasurer           jra823a@netscape.net 
   

(Continued from page 1) 
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Tech News 
 

By Sue Crane, Editor, Big Bear Computer Club 
www.bigbearcc.org 
sue.crane@charter.net 
 
Free services are being used to install malicious code 
 
Cybercriminals are increasingly using blog sites, photo album sites, 

fan and greeting card sites and other free online services to install and 
spread software designed to steal personal information or hijack a victim’s 
PC. In the first two weeks of July, security company Websense saw more 
than 500 incidents of such attacks. The free services are an anonymous and 
affordable way for attackers to store and spread their malicious code. Be 
careful what you click on! 

 
Insect “extermination” via mini robots.  
Scientists in Lausanne, Switzerland, have successfully infiltrated a col-

ony of roaches with a micro robot according to a report published in the 
June issue of IEEE Robotics & Automation. Called InsBot, for “insect-like ro-
bot,” the mechanical bug mimics the insects’ smell and movements so  the 
roaches have accepted it as their own.  

 
Vector Capital purchases WinZip 
WinZip,is one of the most popular shareware programs on the Web. 

More than 140 million people have downloaded the program, and it’s 
downloaded for free about 500,000 times a week. Turnaround investor Vec-
tor Capital. will try to change that by reminding users a little more firmly 
that the software costs $29 (after a free 30-day trial), as well as likely com-
ing out with new features that only paying customers can download. 

 
Better Eating Through Nanotech 
Major food producers are using nanotechnology to improve the quality 

of their foods, although some warn that the technology may be misunder-
stood by consumers. At a Nano4food conference food scientists, material 
scientists and nanotechnicians met to discuss how the technology is being 
used to improve the consistency of yogurt or cheese, packaging technolo-
gies, and even how to “wall off” the most nutritional components of food in 
favor of tastier alternatives. However, as nanotechnology moves forward, 
consumers will have to be informed and educated about the possible bene-
fits and hazards of using it. 

 
(Continued on page 4) 
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Microsoft Finalizes Genuine Advantage 
Microsoft has gone live with the Windows Genuine Advantage pro-

gram. The program, which has been available in an avoidable pilot ver-
sion since late 2004, is now mandatory. Microsoft also noted that it has 
somewhat simplified the Windows Genuine Advantage validation process; 
for example, users are no longer required to enter a 25-character product 
key to validate their software. Users who try to validate software and dis-
cover that they’re unwittingly (or otherwise) running illegitimate copies of 
Windows have a few options. According to Microsoft, qualifying custom-
ers who fill out a piracy report, provide proof of purchase, and send in 
their counterfeit CD-ROMs can receive a genuine copy of Windows XP 
Home Edition or XP Professional Edition (depending on which version 
they’re using) at no cost. Customers who submit a piracy report can get  
XP Home for $99 or XP Pro for $149.  

 
There is no “Superfetch” 
Ed Bott, bestselling author and computer journalist advises:  “The 

same yokels who insist on spreading the “clean out your Prefetch folder” 
BS are now spreading the word that there’s a super-double-secret regis-
try setting in Windows XP called SuperFetch that will reduce boot times 
dramatically. No, there isn’t. And if you see any Web site that tries to in-
sist that there’s any benefit to cleaning out your Prefetch folder or ena-
bling this latest bogus tweak, you should assume that any other advice 
they give you is worthless as well.” 

 
End of analog TV? 
Millions of American television sets that receive only analog over-the-

air broadcasts could go dark if not upgraded by Jan. 1, 2009. That dead-
line was suggested by members of the U.S. Senate’s Commerce, Science 
and Transportation Committee. The committee is readying legislation ex-
pected this year that would require all American televisions to run on 
digital signals by the end of 2008. That would free up the analog, or 700 
MHz, spectrum for other uses. Under current law, analog television would 
be cut off on Dec. 31, 2006, or when 85 percent of households are capa-
ble of receiving digital signals, whichever comes sooner. Last month, the 
FCC proposed to move the date by which all televisions with screen sizes 
of 25 to 36 inches must contain digital tuners up to March 2006. All tele-
visions, VCRs and DVD players would have to carry the technology by 
2007.  

 
New Media Center Device 

(Continued from page 3) 

(Continued on page 5) 



5 

Microsoft will soon ship a wireless Media Center keyboard and remote 
control that will help people who have Media Centers in their living rooms 
interact with the machines. The device features beveled edges for easy 
two-handed holding, an integrated pointing stick, full Media Center re-
mote-control functionality, a full-sized keyboard with special Media Cen-
ter buttons, and even power buttons for the PC and TV. 

 
There is no restriction against any non-profit group using this article as long as it is 

kept in context with proper credit given the author.  The Editorial Committee of the As-
sociation of Personal Computer User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 

 
 

Screen Shots 
By David Garcia, President, Little Blue PC Club, Northglenn, Colorado     
petitbleu@comcast.net 

Have you ever wanted to print out what you see on your monitor 
screen? This is called a “Screenshot,” and there are several software 
packages on the market that allow you to do just that with various de-
grees of sophistication. If you don’t need that sophistication, you can 
easily use Windows to get a screenshot. Just follow these instructions: 

1) Press the Print Screen Key  (PrtScr) on the keyboard. 
2) Click Start, then click Run. 
3) Type “mspaint” (without the quotes) in the Run box and click OK. 
4) In Paint, click Paste in the Edit menu 
5) Click Print Preview in the File menu. If the screenshot is cut off, you 

may want to  change the  printer setting to print in Landscape mode. 
6) Click Print and close Paint. You’re done! 
    You can also save the file if you like: 
1) Click “Save” in the File menu  
2) Browse to the folder you want to save the file in so that the folder 

name is in the “Save In” box. 
3) Type a file name for the screenshot; use JPG  in the “Save as Type” 

box and click Save. 
Article rights are reserved. This article may be reproduced, downloaded, dissemi-

nated, or transferred, for single use by nonprofit organizations for educational purposes, 
with attribution to David Garcia. Little Blue PC Club, Northglenn CO.  It should be un-
changed and this paragraph included. Please e-mail David Garcia at little-
bluepcclub@comcast.net when you use it, or for permission to excerpt or condense. 

There is no restriction against any non-profit group using this article as long as it is 
kept in context with proper credit given the author.  The Editorial Committee of the As-
sociation of Personal Computer User Groups (APCUG), an international organization of 
which this group is a member, brings this article to you. 

 

(Continued from page 4) 
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Internet Explorer Tips and Tricks 
by Richard O. Johnson, TUGNET 

rj@theskillspool.org  
  
Internet Explorer, despite inroads made by Firefox and other browsers, 

overwhelmingly remains users' browser of choice (perhaps because it 
comes bundled with all new Windows computers). The following pointers 
are designed to help you get the most out of your use of Internet Explorer. 
They're written with IE6 in mind, although most will apply to earlier ver-
sions, and some may apply to other browsers as well. 

  
Use keyboard shortcuts 
  
My regular readers will know that to increase efficiency I strongly en-

courage the use of keyboard shortcuts in preference to the use of the 
mouse. Here are my favorite IE keyboard shortcuts: 

 Use Alt-Home to bring up your home page.  
 Use Ctrl-H to open or close your history pane.  
 Use Ctrl-I to open or close the Favorites pane.  
 Use Ctrl-B to organize your Favorites  
 Use Ctrl-N to duplicate the active page in a new window.  
 Use Ctrl-F to find a word, partial word, or phrase on the current web-

page.  
 Use Backspace (or Alt-Left) instead of the IE Back button, to navigate 

back.  
 Use Alt-Right to navigate forward.  
 Use F11 to toggle full-screen mode.  
 Use Alt-D to move to the address bar. (Or use Ctrl-O, and you won't 

need the address bar! See “Other” Tip 3, below, for details.)  
 Once in the address bar, use Enter to bring up the specified webpage 

or Ctrl-Enter to first surround what you've typed with “www.” before and 
“.com” after, and then bring it up.  

 Use F5 or Ctrl-F5 to refresh a page. It's a good idea when refreshing 
to routinely hold down Ctrl (whether you're using the keyboard or the 
mouse), to bypass the IE cache and give you a more effective refresh. 

Optimize the toolbar 
  
Unless you maintain only a dozen or so Favorites, you'll want to take full 

advantage of the Links option for the IE toolbar, which you activate with the 
right-click toolbar menu. Drag the Favorites you'll want to have most 
prominent into the Links section of the toolbar. Using the right-click Proper-
ties menu of each “Link,” you'll probably want to assign it a unique icon 

(Continued on page 7) 
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and, to save space, rename it to a shorter form. 
Tip: You can save additional space by shortening the “Links” title on the 

toolbar. Unfortunately, simply renaming the “Links” folder won't work. You'll 
need to open the Registry Editor, by choosing Run from the Start menu and 
typing regedit. After pressing Enter, drill down to HKEY_CURRENT_USER > 
Software > Microsoft > Internet Explorer > Toolbar. On the right-hand side 
you'll see LinksFolderName=“Links.” Change the word within the quotation 
marks to a one-character name you'd like to use instead, perhaps “.” or 
“+,” and close the Editor. (Use extreme caution, as making a wrong entry 
in the Registry Editor can have dire consequences!) 

You should unclutter the toolbar by instructing it to “Remove” nearly all 
the toolbar buttons. These not only occupy valuable space but can actually 
interfere with efficient browsing (by discouraging use of the keyboard short-
cuts described above). You get to the Remove command via “Customize,” 
on the right-click menu. Of the built-in IE toolbar buttons, the only ones I 
recommend displaying are those for Size and Back. All the other button 
functions can better be facilitated via the keyboard or by other means. (For 
a complete list of IE keyboard shortcuts, go to http://snipurl.com/bskn. The 
reason for keeping the Back button is its associated pull-down menu.) 

  
Keep IE secure 
  
It goes without saying that you need to keep IE fully patched, perhaps 

with the use of Windows Update or Microsoft Update. But what of the Inter-
net Explorer security settings (accessible via Tools > Internet Options > Se-
curity)? 

  
In the “Internet Zone”--the default zone for a webpage--it's prudent to 

be more rather than less restrictive. (Better safe than sorry!) The easiest 
way to go is simply to move the “Default Level” slider to High. Or you could 
use the “Custom Level” to make a determination for each setting. In that 
case you may want to consult a guide such as the one at 
www.techspot.com/tweaks/ie6/ie-5.shtml.  

  
Remember that if your security restriction interferes with the proper 

viewing of a page, Windows will let you know--although most often you'll be 
able to view the page just fine notwithstanding what Windows says. To re-
move the restriction for a given page, you can add that page to your 
“Trusted” sites, against which the restriction won't ordinarily apply. (You 
may have to refresh the page after adding it.) To simplify moving webpages 
to your trusted list, a free program is available at www.geeksuperhero.com/
zones.shtml.  

(Continued from page 6) 

(Continued on page 8) 
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An alternative method does not require you to move all such sites to the 

Trusted zone. For this you'll need the laudable Push the Freakin' Button 
software, available at modest cost at www.tlhouse.co.uk/PTFB.shtml. With 
PTFB in place, use IE's Custom Level to choose “Prompt” instead of 
“Disable” for every feature except any that you're absolutely sure you'll 
never want to use. Then instruct PTFB to push the “No” (disallow) button 
when the prompt appears. Should you decide to permit the feature in ques-
tion, you can with a double click disable PTFB, and just as easily re-enable 
it when done. 

  
A good (free) test to assess your IE vulnerability may be found at 

http://snipurl.com/ietest. 
  
Other tips 
1. To execute a link in a new window, hold down Shift. 
2. Is IE acting strangely? You can often fix it by using the IE Repair util-

ity accessible via Add/Remove Programs (in the Windows Control Panel), 
upon  selecting “Microsoft Internet Explorer” and then “Add/Remove.”  

3. You can dispense with the address bar, by using Ctrl-O to open a 
webpage or other location. You can then completely hide the address bar 
(using the IE toolbar's right-click Customize function) or shrink it down to 
its title only (having first “unlocked” the toolbar, also with the right-click 
menu). Losing the address bar will eliminate the temptation to go there 
with the (less efficient) mouse, and can free up space that may be better 
put to other use. On the downside, you'll also lose the functionality of the 
Ctrl-Enter address bar shortcut (see Keyboard Shortcuts, above).  

4. You might be able to save considerable time if you bypass your home 
page (start page) when you don't need to see it. Here's how: Enter 
“about:blank” [without the quotes] in the IE address bar, to create a blank 
quasi-webpage. Then use Right Click + F to turn that page into a Favorite, 
and drag the new Favorite's icon into the Quick Launch section of your Win-
dows task bar, before deleting the Favorite. You may want to assign a dif-
ferent icon to your new IE shortcut with the use of its right-click Properties 
menu. (You can use this same technique to set up a “secondary home 
page” instead of a blank page.) 

Add-ons 
  
Useful IE add-ons, free except as noted, include: 
 Google Toolbar, at toolbar.google.com, which enables too many use-

ful features to even hint at here. Highly recommended.  
 Favorites Search, at www.dzsoft.com, which lets you speedily locate a 

(Continued from page 7) 

(Continued on page 9) 
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Favorite, no matter how many you've stored.  
 Y!Q DemoBar, at yq.search.yahoo.com/splash/demobar.html, which 

enables context-based searching. This can easily be squeezed onto the 
same line as the IE address bar.  

 ieSpell, at www.iespell.com, which will quickly spellcheck all the text 
you've entered in any Web form.  

 AddaButton, at www.harmonyhollow.net/aab.shtml, which will let you 
fit more buttons onto the IE toolbar. These buttons can open documents 
and applications (not just websites) and don't require space-consuming dis-
played names. Shareware, $11.95  

Richard Johnson is a writer and editor, and founder/administrator of FREE FOR ALL The 
Skills Pool, a 29-year-old membership organization (http://theskillspool.org). He is a vol-
unteer with TUGNET HelpContact for assistance with Internet Explorer, Outlook Express, 
and Gmail. He welcomes feedback, at rj@theskillspool.org. 

There is no restriction against any non-profit group using this article as long as it is 
kept in context with proper credit given the author.  The Editorial Committee of the Asso-
ciation of Personal Computer User Groups (APCUG), an international organization of which 
this group is a member, brings this article to you. 

 

(Continued from page 8) 
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 Reading Product Manuals Online 
By Gabe Goldberg, APCUG Advisor; Columnist, AARP Computers & 
Technology Website 

 
I'm reasonably well-organized; my wife thinks I'm a packrat (she keeps 

trying to sneak my '70s shirts to the thrift shop). You'd think this would 
mean that I can find product manuals for every appliance, gadget, PC com-
ponent and software, etc., I've ever bought. That's mostly true. 

But sometimes my filing system fails me. Or I've forgotten to whom I 
loaned something. Or someone else in the house (but I'm not naming 
names) has moved it. What then? 

Fortunately, manufacturers are increasingly making product literature 
and documentation available online. While this isn't entirely out of generos-
ity -- it reduces their customer-support workload -- it's great for consumers 
who can find and read the material. 

A good starting place is the manufacturer's Web site. For example, I'm 
writing this article using a Samsung SyncMaster 912n LCD video monitor.  
Suppose I need to know what its control buttons do but can't find its man-
ual. Samsung's home page [www.samsung.com] offers a button, 
"Download Center: Download Drivers, Manuals, Software, and Firmware". I 
can either enter a product model number or name, or search via product 
group (audio/video, computers, etc.), then product type, then product sub-
type, and model name. 

Computers are very precise; searching took three tries, since it wanted 
only "912n", not "SyncMaster 912n". The manual was then available in any 
of 28 languages, from Bulgarian to Chinese. A PDF file (see below for expla-
nation), it's just under three megabytes, dated about a month ago, com-
plete, 83 pages including clickable Table of Contents. So a minute after de-
ciding to look for it, I'm looking *at* it. 

Another way to search is via Google [www.google.com] entering terms 
like 912n manual site:samsung.com which only searches the samsung.com 
Web site. This took me to the right neighborhood on the Web site but left 
me needing a few more clicks to hit the manual. Sometimes search engine 
results are better than navigating within a site, so consider both tech-
niques.  

Manufacturers often update online material as mistakes or shortcomings 
are found in printed versions, so for important products it's worth checking 
Web sites occasionally. Sadly, they also sometimes package only abbrevi-
ated versions with products, suggesting or expecting consumers to 
download full versions. 

Either way, online manuals are also useful when considering purchases 
or comparing choices, since they give -- or should give! -- more complete 
and useful information than is printed on the box. If you're evaluating 
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something pre-purchase, evaluate the manual's organization and quality -- 
Will you be able to find information you need? Will you understand it? If 
you're buying something used, online availability of a missing manual can 
make the acquisition much more pleasant. 

Online manuals can be in many formats -- HTML (normal Web pages), 
Microsoft Word documents, PDF (Portable Document Format), and others. 
Each format has advantages and disadvantages. HTML is nearly universal; 
if you can view Web pages you can read HTML documentation. But it may 
be harder to download and save/organize all pieces of a large document. 
You'll need Microsoft Word software (or free reader) to read MS Word files. 
Flexible PDF is becoming the most popular online document format, but it 
too requires software, Adobe's Acrobat Reader, for viewing. Fortunately, 
this is free and easy to download/install; visit Adobe [http://
www.adobe.com/] and click Get Adobe Reader. 

Some manufacturers take a different approach, offering search tools 
and links within their Web sites for different material, such as overviews, 
tutorials, problem solving tips, even video clips illustrating usage.  

Finally, LiveManuals [www.livemanuals.com] takes an interesting/
interactive approach, providing interactive product demonstrations. Though 
it doesn't include every product – office equipment and appliances aren't 
presently well-represented -- the Wish List page accepts nominations for 
items to add.  

This article originated on AARP's Computers and Technology Web site, www.aarp.org/
computers, and is copyrighted by AARP. All rights are reserved; it may be reproduced, 
downloaded, disseminated, or transferred, for single use, or by nonprofit organizations for 
educational purposes, with attribution to AARP. It should be unchanged and this paragraph 
included. Please e-mail Gabe Goldberg atgabe@gabegold.com when you use it, or for per-
mission to excerpt or condense. 

There is no restriction against any non-profit group using this article as long as it is 
kept in context with proper credit given the author.  The Editorial Committee of the Asso-
ciation of Personal Computer User Groups (APCUG), an international organization of which 
this group is a member, brings this article to you. 

(Continued from page 10) 
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Lessons Learned Too Late – Another Attack of the 
Killer Worms 

By Ira Wilsker, APCUG Director;  
WEBSITES: 
http://www.microsoft.com/malwareremove 
http://vil.nai.com/vil/stinger 
http://www.aladdin.com/esafe 
http://www.microsoft.com/technet/security/bulletin/MS05-039.mspx 
http://housecall.antivirus.com 
http://www.bitdefender.com 
 
You may have recently heard reports in the media about some strange 

computer worms that attacked thousands of computer networks, effectively 
shutting them down.  In a society that likes to place blame for every nega-
tive event, blame has been placed on a variety of places, such as Microsoft 
for creating vulnerable software, to the users who had not properly and im-
mediately patched their operating systems, or updated their antivirus pro-
tection.  As it is often typical in these circumstances, very little blame has 
been placed on the miscreants who created and released these computer 
worms. 

While the financial damage done by these worms, commonly called by 
the names Zotob, PnP-worm, Rbot, and several other monikers, was less 
than some of the more disastrous worm and virus attacks, it was still sub-
stantial.  Media reports account for thousands of computer networks and 
systems shut down for various periods of time while IT staff attempted to 
identify and repair the damage.  Typical of the damage reported, caused by 
these computer worms, was the 50,000 employees of 13 Daimler-Chrysler 
assembly plants in Illinois, Indiana, Wisconsin, Ohio, Delaware and Michi-
gan, who were idled for nearly an hour while technicians restored the com-
puters which control the plants.  Up to fifty thousand lost man-hours of 
auto production can easily amount to significant production losses.  Other 
victims of this same series of computer worm attacks, as reported by the 
national media were SBC Communications, Associated Press, ABC and CNN 
networks, the New York Times, Caterpillar, U. S. Customs, and many oth-
ers.  SBC reported that the computer utilized by its customer service em-
ployees kept rebooting as a result of the worm infections.  U. S. Customs 
Service reported long delays in processing international passengers as its 
computer center in Virginia was effectively shut down for about five hours, 
resulting in major delays at locations as diverse as Miami and New York as 
Customs agents utilized printed lists or backup computer systems.  The 
county wide 911 emergency phone system in Jefferson County, Washing-

(Continued on page 13) 
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ton, was disrupted for about 10 hours. These are but a few of the examples 
of the damage and inconvenience caused by a recent attack of computer 
worms. 

What these worms all have in common is that they all rely on a recently 
disclosed vulnerability in several Windows operating systems, and exploit a 
security hole in Windows’ “PnP” or “Plug and Play” service, a feature in-
tended to detect new hardware installed on Windows computers, and auto-
mate the configuration process.  An August patch (MS05-039) intended to 
close the vulnerability, which Microsoft labeled as “critical”, was released on 
August 9, shortly before the worm attacks, but the time between the re-
lease of the patch and the attacks was so short, that countless organiza-
tions had not yet installed the patch on their computer systems.  The con-
cept and crude code of a computer worm that could exploit the vulnerability 
was posted to a security website often read by hackers and crackers on a 
Wednesday evening, and by Saturday morning the first variant of the Zotob 
worm, named Zotob.A appeared in the wild and started its attack.  Within a 
matter of a few days, several other variants of Zotob have appeared, along 
with a slew of similar worms, such as the Rbot, and began wreaking their 
havoc. 

Some commercial computer networks using sophisticated antivirus soft-
ware that depends heavily on “heuristics” or software behavioral patterns, 
rather than the digital signatures commonly utilized by most of the retail 
antivirus products intended for home use, escaped damage, because they 
work proactively before an attack can take place, rather than reactively, af-
ter attacks have been reported.  One of the examples of such commercial 
software that protected companies from attack proactively was Esafe, from 
Aladdin Software (www.aladdin.com/esafe). 

Acknowledging that there are still Windows computers that are infected 
with the major forms of malware, Microsoft released a free utility that can 
remove Zotob along with its variants, and several other major viruses and 
worms.  This utility can be downloaded for free at www.microsoft.com/
malwareremove.  It should be noted that this Microsoft utility will only re-
move a few dozen of the most common worms and viruses and their vari-
ants, such as Bagel, Sober, and Netsky, but is not a substitute for a prop-
erly updated antivirus program.  The antivirus software publisher McAfee 
also had a similar free downloadable utility at vil.nai.com/vil/stinger. The 
free online antivirus scans, referenced in a previous column here, such as 
those from Trend Micro (housecall.antivirus.com), BitDefender 
(www.bitdefender.com), Panda (www.pandasoftware.com), and others, can 
detect and remove much more malware than the limited downloadable utili-
ties. 

Sadly, pain is an excellent teacher, and hopefully we have learned our 

(Continued from page 12) 
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lesson.  It is now more imperative than ever that security patches be 
promptly and properly installed both on our home computers as well as dis-
tributed throughout our vast commercial computer networks.  It is also im-
perative that appropriate protective software, such as antivirus, firewall, 
and anti-spyware software be installed and updated constantly. 

With proper and timely protection, we can do much to protect our sys-
tems from more devastating computer virus and worm future attacks which 
are sure to come. 

There is no restriction against any non-profit group using this article as long as it is 
kept in context with proper credit given the author.  The Editorial Committee of the Asso-
ciation of Personal Computer User Groups (APCUG), an international organization of which 
this group is a member, brings this article to you.  

 

Tips for Adding Audio and Video (for Free) to Your 
User Group Web Site 

By Phil Shapiro, member of the Capital PC User Group, Virginia Macin-
tosh Users Group, Washington Apple Pi, Young Hackers and Scholars Libre 
Users Group 

 
When people visit your user group web site, almost all of them want to 

know the answer to two questions: 
Who are these people? 
What do they care about? 
You can try answering these questions with words and pictures. That 

sort of works. Or you can add audio and video to your user group web site, 
completely free of charge using the Internet Archive (http://
www.archive.org), and bring your club to life in whole new ways. 

I've been experimenting with this in the Virginia Macintosh Users Group 
and have learned some things worth passing along. You can view the video 
I uploaded at http://www.archive.org/details/vmugtestimonials2 . Now I'll 
explain how I created and uploaded it. 

A few years ago I carried my digital camcorder, tripod and some lighting 
to a VMUG meeting. We meet in the large library of a middle school, so I 
set up my camcorder in a side area of the library. During the meeting I dis-
cretely went around the room asking folks if they wanted to say a few 
words on camera in support of the club. This was entirely spontaneous and 
unrehearsed, so the club could best collect people's genuine sentiments. 

It didn't take much time or effort to gather these short testimonials. I 
then edited these testimonials together in iMovie and created an MPEG-1 
file from them via the Share option in the File menu of iMovie. (To create 
an MPEG-1 file you need to have Roxio Toast, a commercial program, in-
stalled on your Mac.) It's useful to note that the file name suffix of MPEG-1 

(Continued from page 13) 
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is .mpg 
MPEG-1 files can be viewed by Macintosh, Windows and Linux users. 

These files are admittedly a bit on the large size in terms of megabytes per 
minute of video. Each minute of MPEG-1 video is 10 megabytes. But their 
universal viewability is a great attribute. 

I uploaded this 9-minute (87 megabyte) file to the Internet Archive. The 
process of uploading video to the Internet Archive is fairly simple, but let 
me explain the steps anyway. First you need to create an account for your-
self on the Internet Archive. It's free and takes just a few steps.  

Then you need to upload your video file or files. I used the popular 
Fetch FTP (file transfer protocol) program for Macintosh computers. Cyber-
Duck (free) works equally well. On the Windows side of things, SmartFTP is 
the best free FTP programs I know of. 

After logging in to your Internet Archive account, the first step is to cre-
ate a folder (subdirectory) for each video (or audio) file. The folder name 
needs to be almost identical to the file name. So if you want to upload the 
file named vmugtestimonials2.mpg your folder name should be vmugtesti-
monials2. (without the period at the end). Next you open the folder you've 
created (by double clicking on it) and drop the file you want to upload into 
that folder. The upload process can take a while, even if you have a high 
speed Internet connection. A rough rule of thumb is that you can upload 
about 1 to 3 megabytes per minute with most DSL and cable modem ac-
counts. Using a Verizon FIOS (fiber optic) account, you can upload about 12 
to 15 megabytes/min. 

After the file has been uploaded, you need to wait about 6 to 8 hours 
before the file is "released." (There are people at the Internet Archive that 
check to make sure the file was safely received at their side and is not inap-
propriate.) 

The final step is to "Import" the file into the Internet Archive, giving it a 
detailed file description and including other relevant information, such as 
who produced it and what the duration of the file is.  

You can also choose which Creative Commons license you would like for 
this file, or whether you'd like to donate your file to the public domain.  
While Creative Commons licenses are a wonderful invention, donating your 
file to the public domain might be the most sensible (and least complicated) 
way to proceed. 

After you've imported your file into the Internet Archive, you need to 
wait just a bit longer (usually just a few hours -- or less), and then your file 
will be available for any and all to view -- in perpetuity. (Roughly until when 
the sun blows up.) 

Here's the part you're going to like a lot. If you upload MPEG-1 files to 
the Internet Archive, and if the file has a suffix of .mpg, then the Internet 
Archive automatically creates 2 smaller file size versions of this video in 

(Continued from page 14) 
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Chasing the Internet 
By Gabe Goldberg, APCUG Advisor; Columnist, AARP Computers & 
Technology Website 

 
A long-ago famous and favorite I Love Lucy episode [www.tvtome.com/

tvtome/servlet/GuidePageServlet/showid-1038/epid-15119/] showed Lucille 
Ball and sidekick Ethel facing an ever-faster conveyor belt delivering choco-
lates for them to wrap: they couldn't keep up. The Internet sometimes 
makes me feel as though I'm at the wrong end of that conveyor belt. 

I confess that I don't always reduce online interruptions and information 
coming at me. I'm not yet a recovering info-junkie, so this article is defi-
nitely "do what I say, not what I do" advice. 

The Internet is like the accelerating candy conveyor belt. There's more 
content (online newspapers, portals, Web rings, etc.) and more forms of 
content (e-mail initially, then Web sites, mailing lists, blogs, streaming au-
dio/video, downloadable music, Web cameras, etc.) 

But even with today's pace of change, whether we do it deliberately or 
just let it happen, we create our own online experiences. So we can make it 
fit our needs and change it when necessary. I've sometimes resisted drop-
ping e-mail lists because I once liked them. That's silly: my and your most 
precious resource is time. 

So I'll share time savers: 
Tell people what you're interested in; if they scan online and offline re-

sources for you, you don't have to.  
Tell people what you don't want! If you don't want jokes, motivational 

sayings, political news, etc., cancel your subscriptions by asking people to 
stop sending it. I like jokes, I like technology, I'm interested in politics. But 
some people just aren't on my wavelength. 

When you send e-mail or reply, don't send unnecessary copies. Encour-
age people to not copy you unless you need to know or do something about 
the topic. 

When replying, trim what you quote to essential matter and (especially) 
encourage others to do the same for you. Bloated and repetitive reply-
reply-reply notes waste time while you look for what's new!  

If you send common replies or send periodic e-mail such as club meet-
ing notices, use templates (stored copies of pre-formatted e-mail) so you 
can just fill in details but needn't enter text repeatedly.  

Use e-mail and spam filtering. Most e-mail software can automatically 
route spam to a special folder (and, of course, I'd like to route spammers to 
a special place). Some spam filters learn what's spam based on what you 
flag, so their accuracy improves over time. My spam is increasingly filtered, 
and no real e-mail is filtered. You can also set rules for routing e-mail into 

(Continued on page 17) 
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folders for easier reading and management. Based on rules I've defined 
(special keywords in e-mail subject and sender fields), my e-mail is put in 
folders such as AARP, Lists, To-Read, and Travel. This lets me organize e-
mail time, prioritize my reading and answering, and sometimes catch up by 
deleting an e-mail category I don't really need to read. And the best part is 
that I avoid interruptions of each note arriving, since routing takes place si-
lently and invisibly. 

Set discussion mailing list subscriptions to "digest mode". This groups 
list e-mail into fewer/larger notes, sent occasionally, sometimes once/daily. 
This has two benefits: it eliminates many interruptions, and it greatly re-
duces the temptation to answer list notes, since by the time you see some-
thing someone else has likely already answered it. 

Pick times during the day to handle e-mail, read favorite Web sites, use 
instant messaging, etc.; ignore it all at other times. This allows focusing on 
tasks at hand, reduces frenzied multi-tasking (trying to do many things at 
once), and lets you actually finish things you start!  

Don't be trapped by time-wasting habits. Use technology that matches 
your needs; change it for yourself, not because people urge you to (there's 
peer pressure at all ages!); adopt changes such as broadband Internet that 
save you time but be selective in what it brings you.  

Recognize that the conveyor belt always wins the race and focus on 
what really matters -- most of which, after all, isn't even online. 

This article originated on AARP's Computers and Technology Web site,  
www.aarp.org/computers, and is copyrighted by AARP. All rights are reserved; it may be 
reproduced, downloaded, disseminated, or transferred, for single use, or by nonprofit or-
ganizations for educational purposes, with attribution to AARP. It should be unchanged and 
this paragraph included. Please e-mail Gabe Goldberg at gabe@gabegold.com when you 
use it, or for permission to excerpt or condense. 

There is no restriction against any non-profit group using this article as long as it is 
kept in context with proper credit given the author.  The Editorial Committee of the Asso-
ciation of Personal Computer User Groups (APCUG), an international organization of which 
this group is a member, brings this article to you. 

(Continued from page 16) 
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OPEN LETTER to user group newsletter editors and 
columnists 

from Linda Gonse, ORCOPUG (Orange County IBM PC Users’ Group) 
Nibbles & Bits editor 

editor@orcopug.org 
www.orcopug.org 
If you read my past Notepad articles in this newsletter, you know how I 

feel about spyware. This month, I was reading a paid online newsletter by 
Brian Livingston, when I ran across an article which is excerpted below. 

This news is really outrageous. Consumers actually seem only to be 
pawns in this spyware assault that benefits those who have committed 
themselves to making profits using unethical methods.  

I’d like to enlist the aid of other newsletter editors and newsletter col-
umnists, to alert members and others to this insidious menace. We should-
n’t “get used” to it. And, we shouldn’t be silent about it. We deserve better.  

In fact, as citizens, we should protest this blatant invasion of our pri-
vacy, and the vandalism of our personal property.  

Update Windows Media Player to avoid surprises 

Late in 2004, computer experts noticed that a popular Windows Media 
Player video file was actually a silent delivery mechanism infecting millions 
of PC users with spyware. 

On Jan. 3, 2005, security researcher Ben Edelman, 
www.benedelman.org/news/010205-1.html, revealed what was happening 
to people who played this video file in WMP. After clicking the OK button 
on a single, legitimate-looking “browser update” dialog box, “My computer 
quickly became contaminated with the most spyware programs I had ever 
received in a single sitting,” he said. 

Edelman counted an amazing total of 31 programs that had silently 
been installed, without even displaying a license agreement. These in-
cluded adware from 180solutions, CoolWebSearch, Ezula, ISTbar, and 
many other adware companies, he said. (A July 14 report by Brian 
Livingston, coauthor of Windows 2000 Secrets, and Windows Me Secrets, 
said that Microsoft’s AntiSpyware beta program stopped recommending 
the removal of programs by 180solutions, Ezula, and some other adware 
companies to the dismay of spyware experts.)  

Microsoft initially said the misleading dialog boxes were using a “by-
design feature” of WMP, which wouldn’t be changed. The company then 
reversed course, telling eWeek http://www.eweek.com/
article2/0,1895,1752247,00.asp in January that a patch would be available 
by mid-February.  

(Continued on page 19) 
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Playing a video file in Windows Media Player can launch a dialog box 
that looks official but installs spyware. 

I’m not pointing to Microsoft as THE one to blame for spyware. But 
rather saying even a legitimate company’s product can be the source of 
spyware. There is profit in allowing spyware to be distributed with a desir-
able product.  

Ben Edelman also noted on his website that, “As in my prior video of 
spyware installing through security holes, www.benedelman.org/
news/111804-1.html my records make it possible to track down who’s be-
hind the installations — just follow the money trail, as captured by the 
“partner IDs” within the various software installation procedures. When one 
program installs another, the second generally pays the first a commission, 
using a partner ID number to track who to pay. These numbers make it 
possible to figure out who’s profiting from the unwanted installations and, 
ultimately, where the money is going.”  

So, who can you trust? Don’t say the antispyware makers. Several are 
on the payroll of companies who struck deals to be delisted as spyware!  

Apparently, many businesses can’t resist the opportunity to make easy 
cash. It is up to the customers—US, YOU and I — to resist being harvested 
as a money crop.  

Make no mistake, we are the only ones who care about customer rights 
or privacy.  

I’ve been reminded that keeping Windows updated may help to prevent 
spyware installations.  

But, this is the real world. Not everyone drives with a seat belt fastened, 
stays alert while standing at an ATM, or keeps Windows updated. 

Even if we only write a paragraph a month about any new spyware ad-
vance, program, or experience, etc., it will be good. We need to keep re-
minding our members, our vendors, and our lawmakers that this is some-

(Continued from page 18) 
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thing we DO NOT want. 
If enough ruckus had been raised at the beginning, spyware might have 

been stopped in its tracks. Don’t make this mistake twice. Raise a ruckus 
now! And, keep raising it until spyware is declared dead—dead wrong! 

There is no restriction against any non-profit group using this article as long as it is 
kept in context with proper credit given the author.  The Editorial Committee of the Asso-
ciation of Personal Computer User Groups (APCUG), an international organization of which 
this group is a member, brings this article to you. 

 

(Continued from page 19) 
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Bryon Palitto 
 

- Male 
- Born on 7-22-68 in Akron, OH 
- 20years of Programming / IT / Project Management Experience 
- Bachelor of Science in Computer Science, May 1991 
 
Bryon started of his career in Technology working for the University of Akron troubleshooting 
programming problems while going to school.  Also during college, he  Co-opted for the North 
East Ohio Regional Sever District, doing data capturing and analysis to provide justification of 
remediation projects.   
 
After graduating, he we to Harper Rose in Akron, OH as their Data Processing Manager.  He 
worked as the Data Entry Supervisor, System Analyst, Programmer and Tech Support person.   
 
Gaining lots of experience here in a wide array of hardware, software and programming lan-
guages, his career was catapulted to the next level as he went to work for Curtis Research, Inc. 
in Akron, OH  as a Software Engineer.  He was responsible for all new Medical Billing soft-
ware product design and development, using several complex and powerful programming lan-
guages.  He also had the oversight to support and maintain all products as last resource; train 
the technical support team that successfully completed 120 installations.  Bryon was looked to 
as their Communications and Network Specialist as well. 
 
Wanting to round off his IT and programming knowledge, he took an opportunity to get some 
sales experience, and went to work for Ciber, Inc. in Independence, OH.  As an Account Man-
ager, Bryon added over $1.5 million in new business within a year and a half. He was given re-
sponsibility for their top three accounts, and developed 100% vertical growth within them.  He 
assisted in every aspect of the business; from accounting to network and telephone system sup-
port and maintenance.  
 
Recognizing his tremendous ability in the Information Technology world, coupled with his 
amazing sales ability and a good understanding of business, in 1996 Bryon decided to start his 
own company, Palitto Consulting Services, Inc.  Today, his team of 17 people provide services 
to over 400 businesses in the state of OH and in several other states as well.  Bryon and his 
team are proficient in over 30 programming languages, Database design, Analysis, Tuning, and 
Programming Design / Development. Also providing the entire spectrum of Local Area and 
Wide Area Networking services.   
 
Managing multiple resources both inside and outside to accomplish project goal on time and 
within budget is what PCS strives for and delivers.  Not industry specific, PCS has done work 
in many environments, with many languages in many industries. 
 
Bryon lives in Wadsworth, OH with his wife and 4 children. 
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ACPCUG Club News 
OLDER VENUE! AKRON North Hill Library 
Maps & Description on ACPCUG Website, www.acpcug.org 
 

NOTE TIME is 6:00PM Sharp! This is because we 
get kicked out at 8:30 PM. 
FROM North or South on Rt. 8 freeway: Exit West on Cuy-
hoga Falls Avenue. Head west ca. 2/3 mile, library on right 
side (north). Take street east side of library and turn left 
into parking lot. (If you hit Main St., come back 200+ft). 
 

Upcoming Computer Shows: 
No Peter Trapp Shows in 2005 announced yet.  

Club Officers    area code 330, unless noted otherwise 

President Frank Ramsey (2007) 699-4711 aframsey@yahoo.com 

VP, Community Liaison Rick Lubinski (2005)  928-7179 lubinski@bright.net 

Secretary Walt Ruthenburg (2006)     283-7867 wruthenburg@usa.net 

Assistant Treasurer Murray Davis (2006) 440-248-
0021 

murray5050@yahoo.com 

Newsletter Editor Art McRowe 666-3189 acpcugnews@yahoo.com 

VP, Software Evaluation  Dave Bohm (2007) 762-6745 bohm320@aol.com 

Treasurer Jim Albright (2005) 923-8686 jra823a@netscape.net 


